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Copyright and Trademarks 
Copyright © 1995, 2009, Oracle and/or its affiliates. All rights reserved. 

This software and related documentation are provided under a license agreement containing 
restrictions on use and disclosure and are protected by intellectual property laws. Except as 
expressly permitted in your license agreement or allowed by law, you may not use, copy, 
reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or 
display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation 
of this software, unless required by law for interoperability, is prohibited. 

The information contained herein is subject to change without notice and is not warranted to be 
error-free. If you find any errors, please report them to us in writing. 

If this software or related documentation is delivered to the U.S. Government or anyone licensing it 
on behalf of the U.S. Government, the following notice is applicable: 

U.S. GOVERNMENT RIGHTS 
Programs, software, databases, and related documentation and technical data delivered to U.S. 
Government customers are "commercial computer software" or "commercial technical data" 
pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental 
regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject 
to the restrictions and license terms set forth in the applicable Government contract, and, to the 
extent applicable by the terms of the Government contract, the additional rights set forth in FAR 
52.227-19, Commercial Computer Software License (December 2007). Oracle USA, Inc., 500 
Oracle Parkway, Redwood City, CA 94065. 

This software is developed for general use in a variety of information management applications. It is 
not developed or intended for use in any inherently dangerous applications, including applications 
which may create a risk of personal injury. If you use this software in dangerous applications, then 
you shall be responsible to take all appropriate fail-safe, backup, redundancy and other measures 
to ensure the safe use of this software. Oracle Corporation and its affiliates disclaim any liability for 
any damages caused by use of this software in dangerous applications. 

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be 
trademarks of their respective owners. 

This software and documentation may provide access to or information on content, products and 
services from third parties. Oracle Corporation and its affiliates are not responsible for and 
expressly disclaim all warranties of any kind with respect to third party content, products and 
services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages 
incurred due to your access to or use of third party content, products or services. 
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Preface 
The Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology 
Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html contains the 
latest versions of the Agile PLM PDF files. You can view or download these manuals from the Web 
site, or you can ask your Agile administrator if there is an Agile PLM Documentation folder available 
on your network from which you can access the Agile PLM documentation (PDF) files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader version 7.0 or later. 
This program can be downloaded from the Adobe Web site http://www.adobe.com. 

The Oracle Technology Network (OTN) Web site 
http://www.oracle.com/technology/documentation/agile.html can be accessed through Help > Manuals 
in both Agile Web Client and Agile Java Client. If you need additional assistance or information, 
please contact support http://www.oracle.com/agile/support.html 
(http://www.oracle.com/agile/support.html) for assistance. 

Note Before calling Oracle Support about a problem with an Agile PLM manual, please have 
the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle 
Technology Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html

Agile Training Aids 

Go to the Oracle University Web page 
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

Accessibility of Links to External Web Sites in Documentation  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 

http://www.oracle.com/technology/documentation/agile.html
http://www.adobe.com/
http://www.oracle.com/technology/documentation/agile.html
http://www.oracle.com/agile/support.html
http://www.oracle.com/agile/support.html
http://www.oracle.com/technology/documentation/agile.html
http://www.oracle.com/education/chooser/selectcountry_new.html
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Chapter 1 

Overview 
This chapter includes the following: 

 Installation Checklist ............................................................................................................................................ 1 
 Obtaining Product Interchange Software from Oracle E-Delivery ....................................................................... 1 
 Hardware and Software Requirements................................................................................................................ 2 

Agile Product Interchange™, which is part of the Agile Content Framework, enables users to rapidly 
identify any structural or parts-related issues in BOMs and AMLs and resolve these issues in a 
systematic fashion. It automates product record handoffs and the refresh of AML records by 
leveraging real-time links to source component intelligence dispersed throughout the supply chain. 
Customers can ensure that product content is synchronized with component events occurring in the 
supply chain, and they benefit from clean, accurate product records across all PLM processes. 

Agile Product Interchange has both database and application components. This document 
describes how to install and configure both components. 
 

Installation Checklist 
Follow these steps to install Agile Product Interchange: 

Install the Agile Product Interchange database. 

See Installing the Product Interchange Database on page 5

 Install the Agile Product Interchange application. 

See Installing and Configuring the Product Interchange Application on page 19

 Configure the Apache Tomcat service. 

See “Configuring the Apache Tomcat Service (on page 23)”. 

 Test the installation by going to the Agile Product Interchange URL. 

See “Testing the Installation (on page 24)”. 

 Use the Agile Product Interchange DataLoad utility to load customer data for manufacturer aliases, part aliases, and 
commodity codes. 

See “Using the Agile Product Interchange Dataload Utility (on page 25)”. 

 
 

Agile Product Lifecycle Management Page - 1 

 

 



Product Interchange Installation Guide  
 
 
 

Obtaining Product Interchange Software from 
Oracle E-Delivery 
Oracle products are distributed as Media Packs. A Media Pack is an electronic version of the 
software. Refer to the Media Pack description or the list of products that you purchased on your 
Oracle Ordering Document. Then, view the Quick Install Guide License List to help you decide 
which Product Pack you need to select in order to search for the appropriate Media Pack(s) to 
download. Prior to downloading, verify that the product you are looking for is in the License and 
Options section of the E-Pack README. Oracle recommends that you print the README for 
reference. 

Download the Oracle Agile Product Interchange Product Pack from Oracle E-Delivery (see Oracle 
E-delivery - http://edelivery.oracle.com) as specified below. 

All Oracle E-Delivery files have been archived using Info-ZIP's highly portable Zip utility. After 
downloading one or more of the archives, you will need the UnZip utility or the WinZip utility to 
extract the files. You must unzip the archive on the platform for which it was intended. Verify that 
the file size of your downloaded file matches the file size displayed on E-Delivery. Unzip the Zip file 
to its own temporary directory. 

Hardware and Software Requirements 
To use the Product Interchange DataLoad utility, Microsoft Excel should be installed on the same 
computer as the Product Interchange application. 

Note Agile Product Interchange is a database-intensive application and can severely impact the 
performance of the Agile PLM application server if they are installed on the same 
machine. Do not install Product Interchange on a system that has the Agile PLM 
application server, File Manager, or JDK 1.5 installed.  

The table below shows the minimum hardware needed to deploy Agile Product Interchange. 

Agi le  9 .2 .2 .4  
Product  In terchange 

Server  

Hardware  Requirements  

Application Server Dual CPU Intel Xeon, 3.0 GHz and above OR 

Dual CPU Ultra Sparc III, 900 MHz and above 

2 MB L2 Cache 

2 GB RAM 

2x36MB SCSI 10K RPM HDD 
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Agi le  9 .2 .2 .4  Hardware  Requirements  
Product  In terchange 

Server  

Database Server Dual CPU Intel Xeon 2.8 GHz and above OR 

Dual CPU Ultra Sparc III, 900 MHz 

512 KB L2 Cache 

1 GB RAM 

2x36MB SCSI 10K RPM HDD 

 

Table 1-2 shows supported platforms for Agile Product Interchange servers. 

Plat forms Database Server  Database Server  Web Server  
 Oracle 9i 9.2.0.1 Oracle 10g 10.2.0.1.0 Tomcat 5.0.30 

Windows 2003 (Intel 
Pentium IV or higher) 

X X X 

Solaris (Ultra Sparc III or 
higher) 

X X Not Supported 
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Chapter 2 

Installing the Product Interchange 
Database 

This chapter includes the following: 

 Installing the Product Interchange Database on Windows .................................................................................. 5 
 Installing the Product Interchange Database on Solaris...................................................................................... 9 

The Product Interchange database is supported on Oracle 9i Release 1 and Oracle 10g Release 2. 
You can find installation instructions for each Oracle version on the Oracle E-Delivery (see Oracle 
E-delivery - http://edelivery.oracle.com) site. 
 

Installing the Product Interchange Database on 
Windows 
To install the Product Interchange database on Windows: 

1. Log in with local Administrator permissions. 

2. Download the appropriate Agile PLM media pack for your operating system. 

3. Extract the contents of the media pack and navigate to the Disk1 \ AgilePI \ DB folder. This folder 
contains subfolders for different Oracle versions. 

4. Open the folder for the Oracle version you have installed (Oracle 9i or Oracle 10g). DB 
installers for all platforms are delivered within the Disk1 \ AgilePI \ DB  folder, regardless of the 
operating system on which you have chosen to install Agile PI. 

5. Double-click the agilepi_db file to start the installation on Windows. 

The Agile Product Interchange Database Configuration Utility appears. Follow the instructions in 
Using the Product Interchange Database Customization Utility on page 6 to configure the 
database. 

Note Unless specified otherwise, all references to Windows specifically require Windows 2003 
with Service Pack 2. Service Packs are available on Microsoft’s Web site, 
www.microsoft.com.        

 

Installation Notes 
For best results, as you install: 

 Follow directions in the order in which they are given. Do not attempt to install any components 
out of sequence.    

 Oracle passwords are not case-sensitive. Agile passwords are case-sensitive. All other text 
entries, such as schema names and folder names, are not case-sensitive. To avoid confusion, 
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all passwords and text entries in this guide appear in lowercase and should be typed as shown. 

 When prompted for a hostname, type the fully qualified name for the host, not the short name. 
For example, if a host is named dbo, type dbo.agile.com, not dbo. 

 

Using the Product Interchange Database Customization Utility 
You can now use the Product Interchange database configuration utility to create and configure the 
database.         

Note The installer creates and configures an Agile Product Interchange database using the 
default values. 

All hard drive indicators show the available disk space. If the space is a negative value, you must 
select another hard drive. 

Important If you change a default value, you must click in the field to ensure that the change is 
activated. 

To customize the Product Interchange Database: 

1. Double-click the agilepi_db file to open the database customization utility.  

2. In the Destination Location dialog box, accept the default location. This is the location where 
files are placed during the database installation. Click Next.  

3. In the Database Size Estimate dialog box, if you are a new Agile customer without an existing 
database to migrate, accept the default (Small). Click Next.  

4. In the Oracle Home dialog box, accept the default unless there is insufficient disk space 
available. This is the location where the Oracle database files were installed.  Click Next.  

5. In the Oracle SID dialog box, accept the default pidb SID. If you want to change the SID, you 
must use a 4-character ID to uniquely identify the Oracle SID. If you want to use an existing 
SID, you must remove it before you can re-use it. Click Next.  

6. In the Database Security and Agile User Information dialog box, accept the default values or 
change to the values specific to your system:  
 Internal/Sys Password is oracle 
 System Password is manager 
 Product Interchange Schema Password is piuser 
 Dralasoft Workflow User Password is dwe 

Click Next.  
7. In the Tablespaces, Redo Log Files, and Control Files dialog boxes, accept the default, unless 

you have additional hard drives with sufficient space available that allow you to distribute the 
files across multiple hard drives. Click Next. 

8.  If you accept the default location for the files on one drive, a message appears notifying you 
about distributing the files across multiple drives (mirroring protection). If this is not an option, 
click Next. Otherwise, click Back and reassign files to different hard drives. 

9. In the Archive Log File dialog box, accept the default, unless you have additional hard drives 
with sufficient space available that allow you to store the file on a different hard drive. Click 
Next. 
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10.   

itional information about language support, refer to the Oracle Globalization Support 

11. ys briefly. You are prompted to install the Product 

rompt window for a while. The window automatically closes 

 the current computer, you need to add and 

1.  > All Programs > Oracle -OraHome92 

t Listener Configuration. Click Next. 

 Listener Name dialog box. Click Next. 
ext. 

. Click Next. 

istant window. 

1. s > Oracle  

al folder and select the Listeners folder. 

4. n the Listening Locations drop-down list. 

2. make the following changes: 

e Directory: d:\oracle\ora92 
 

Note ctory during 

In the Oracle Language Support dialog box, accept the default character set UTF8. Click Next
For add
Guide. 

A Command Prompt window displa
Interchange database. Click Next. 
The script runs in a Command P
when the database is installed. 

 

Adding and Configuring the Listener 
If this is the first time Oracle has been installed on
configure a new address to the Listener settings. 

To add a new Listener address on Oracle 9i:         

Start the Oracle Net Configuration Assistant by choosing Start
> Configuration and Migration Tools > Net Configuration Assistant. 

2. In the Oracle Net Configuration Assistant window, selec

3. Select Add to add a listener to the database. Click Next. 
4. Accept the default listener name, LISTENER, in the

5. Accept TCP as the Selected Protocol. Click N
6. Accept the standard port of 1521. Click Next. 
7. Select No when asked to configure another listener

8. The Listener configuration is complete. Click Next. 
9. Click Finish to close the Oracle Net Configuration Ass

To configure the new Listener address on Oracle 9i: 

Start the Oracle Net Manager by choosing Start > All Program
- OraHome92 > Configuration and Migration Tools > Net Manager. 

2. In the Oracle Net Manager window, double-click the Loc
3. Click the name of the newly created listener, LISTENER. 

Select Database Services i

1. Click Add Database. 

In the dialog box that appears, 
 Global Database Name: pidb 
 Oracle Hom

SID: pidb 

If you used a different global database name or different home dire
the database installation, change the information as appropriate. 

5. Choose File > Save Network Configuration to save your changes. 

To add and configure a new Listener address on Oracle 10g:         

Start the Oracle Net Manager by choosing 1. racle  Start > All Programs > O
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- OraDb10g_home1 > Configuration and Migration Tools > Net Manager. 
2. In the Orac Net Manager window, double-click the Local folder and select the Listeners folder. 

3. e 

le 

Click Creat  in the toolbar to add a listener. The Choose Listener Name dialog box 

5. n the Listening Locations drop-down list. 

2. make the following changes: 

e Directory: oracle_home 
 

Note ctory during 

appears. 

4. Click OK. 

Select Database Services i

1. Click Add Database. 

In the dialog box that appears, 
 Global Database Name: pidb 
 Oracle Hom

SID: pidb 

If you used a different global database name or different home dire
the database installation, change the information as appropriate. 

6.  Choose File > Save Network Configuration to save your changes. 

7.  Open a Command Prompt window and type lsnrctl reload to restart the da
 

tabase listener. 

Configuring Oracle Database Control (Optional) 
 many database administration and 

ance tuning. 

1. acle - OraDb10g-home1 > Configuration and Migration Tools > 

e screen appears. 

3. ions on the Operations page. Click Next. 

4. Next. 

5. ise Manager. Click Next. 
ears. 

6. 

7.  SYSMAN users. Click Next. 

9. 

e Control URL displays. Make a note of this URL 

In Oracle 10g, you can use Database Control to perform
management tasks including SQL perform

To configure Oracle database control: 

Choose Start > All Programs > Or
Database Configuration Assistant. 
The Welcom

2. Click Next. 
Choose Configure Database Opt
The Database page appears 

Select the pidb database you just created. Click 

The Management Options page appears. 

Check Configure the Database with Enterpr
The Database Content page app

Accept the defaults. Click Next. 
The Database Credentials page appears. 

Enter a password for the DBSNMP and

The Connection Mode page appears. 

8. Select Dedicated Server Mode. Click Next. 
Click OK for confirmation. Database configuration begins. 

 When configuration completes, the Databas
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because it is used to log in to the database. 

10. Click Finish to close the Database Configuration Assistant. 

11. Open a web browser and enter the Database Control URL. 

12. Type the User Name and Password of the Product Interchange database. Click Login. 

13. Click I agree to accept the license agreement and display the Database Control page. 

g the Product Interchange Database on 
Solaris 

cle database administrator should install this product. 

ts.         

nstalling an Oracle database on Sun Solaris. The installation 
oc

y and setting additional Oracle functionality. 

e information about installing the Oracle 

 

 2 (9.2.0.1.0) for UNIX Systems: AIX-Based 
d Sun Solaris in 

ology Network at  

You have finished installing and configuring the Product Interchange database. 

Installin

Important   An Ora

Overview 
This chapter provides information for installing Oracle and creating the Product Interchange 
database on Solaris. Before you begin, make sure that you have reviewed all relevant Oracle 
documentation and ensured that the computer meets the minimum system requiremen

Important  For best results, start with a clean system (no previous versions of Oracle). 

This chapter provides information for i
pr ess consists of four major steps: 

  Preparing an installation environment. 

  Installing the Oracle Database Server. 

  Running the Product Interchange database scripts to create the database. 

  Configuring Oracle network connectivit
 

Oracle Source Documentation 

Before you begin, it is important to be familiar with all th
database on Solaris, and with the Optimal Flexible Architecture (OFA) reference material for 
administrators. See the following Oracle documents:   

 Oracle 9i Installation Guide Release 2 (9.2.0.1.0) for UNIX Systems: AIX-Based Systems,
Compaq Tru64 UNIX, HP 9000 Series HP-UX, Linux Intel, and Sun Solaris. 

Oracle 9i Administrator's Reference Release 
Systems, Compaq Tru64 UNIX, HP 9000 Series HP-UX, Linux Intel, an
Appendix G: “Optimal Flexible Architecture.” 

These documents are available on the Oracle Techn
http://otn.oracle.com/documentation/oracle9i.html 
(http://otn.oracle.com/documentation/oracle9i.html). 

 Oracle 10g Installation Guide Release 2 (10.2) for UNIX Systems: AIX-Based Systems, hp HP-
 (SPARC) UX PA-RISC (64-bit), hp Tru64 UNIX, Linux x86, and Solaris Operating System
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cuments are available on the Oracle Technology Network at 

Oracle Database Administrator’s Guide 10g Release 2 (10.2) 

These do
 http://www.oracle.com/technology/documentation/database10gR2.html 

w.oracle.com/techno(http://ww logy/documentation/database10gR2.html). 

ery attempt to be OFA-compliant. Any deviation from OFA Note Agile has made ev
guidelines is noted. 

 

System Requirements 

Before installing Oracle, ensure that your system configuration meets the minimum hardware 
requirements. If you are using a stand-alone system or hosting multiple instances, consider using 

see the Capacity Planning Guide. 

racle database administrator are available to 
equirements. 

the installation environment on Solaris, such as creating the 
nts.            

1. . 

] 

3. d “oinstall” and “dba:” 

4. 

 -d /u01/oracle -s /bin/sh -g  

oup for the Oracle user 

5. r password, and change the Oracle home file ownership: 

r]   

6. 

the recommended hardware requirements for the specific environment to ensure acceptable 
performance. For information on specific system requirements, 

It is suggested that a system administrator and O
monitor system activity and determine resource r

Preparing the Host Computer 
This section describes how to prepare 
necessary groups and user accou

To create the Oracle user account: 

Log in to the system as root
2. Create a home directory for the Oracle user: 

# mkdir -p /u01/oracle [Enter

Create two groups calle

# groupadd oinstall [Enter] 

# groupadd dba   [Enter] 

Create the Oracle user: 

# useradd
oinstall -G dba oracle [Enter] 

where: 

/u01/oracle is the Oracle user home directory 

/bin/sh is the Oracle user login shell 

oinstall is the primary group for the Oracle user 

dba is the secondary gr

Set the Oracle use

# passwd oracle  [Enter] 

Enter password:
# chown oracle:dba /u01/oracle [Ente

Create the Oracle installation directory: 
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# mkdir -p /u01/app/oracle [Enter]   

# chown oracle:oinstall /u01/app/oracle [Enter] 

You must now copy the database scripts. 

To c terchange database utilities:   

1. ate a temporary directory named “agilepitmp:” 

lepitmp [Enter] 

2. der to the agilepitmp directory: 

cle9i

 [Enter] 

3.  uncompress the files from the pidb.tar.Z file: 

nter] 

ter] 

4. 

a 

ers 
omatic shutdown and startup 

To m : 

nter] 

2. ernel parameters. If the parameters do not exist, go to the next 

94967295 

set semsys:seminfo_semmsl=500 

opy the Product In

Change to the Oracle user, and cre

# su - oracle [Enter] 

$ mkdir /u01/oracle/agi
Copy the pidb.tar.Z file from the installation fol

$ cd /cdrom [Enter]   

For Oracle 9i:$ cd /CD1_Agile/Solaris/DB/Ora
For Oracle 10g:$ cd /CD1_Agile/Solaris/DB/Oracle10g
$ cp pidb.tar.Z /u01/oracle/agilepitmp
Change to the agilepitmp directory, and

$ cd /u01/oracle/agilepitmp [E

$ uncompress pidb.tar.Z [En

Extract the pidb.tar file:    

$ tar -xvf pidb.tar [Enter]   

The pidb.tar file contains the following files: 
 pidb.sh — Bourne shell script for creating the database and schem
 profile.txt — oracle user .profile template 
 system.txt — system kernel paramet
 dbora — setup for the database aut
 agilepischema.dmp — schema dump file 

odify the system kernel parameters

1. Change to the root user, and back up the /etc/system file: 

$ su -  [E
# cp /etc/system /etc/system_save [Enter] 

Verify the following /etc/system k
step.   

set shmsys:shminfo_shmmax=42

set shmsys:shminfo_shmmin=1 

set shmsys:shminfo_shmmni=100 

set shmsys:shminfo_shmseg=10 

set semsys:seminfo_semmns=1024 

set semsys:seminfo_semmni=100 
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set semsys:seminfo_semopm=100 

set semsys:seminfo_semvmx=32767 

oexec_user_stack=1 (Note:On Oracle 10g only) set n

Important If you have been running the host computer as an Oracle database server, you have to 
chec g these parameters. For k with your Solaris system administrator before changin
these parameter settings, you can also refer to the Oracle documentation. 

Note Restart the computer if you modify the /etc/system file. 

3. d system.txt file. Append system.txt to 
yste r. 

# cat /u01

d to recover the 

The previous kernel parameters are set in the distribute
/etc/s m if this is the first time you are configuring the host computer as the database serve

/oracle/agilepitmp/system.txt >> /etc/system 

Note Use >> to append. If you have accidentally used >, you nee
original /etc/system file by using cp system_save system. 

4. Restart th

the database creation will fail. You may need 

e system to make the new kernel configuration take effect. 

Note If you do not restart the system, 
to check with your Solaris system administrator for support. 

To set up Oracle environmental variables: 

1. 

2. ironmental parameter file .profile to include:  

E; export ORACLE_HOME 

ct/10.2.0/db_1; export ORACLE_HOME 

ACLE_BASE 

 

3. vious step are set in the distributed profile.txt file. If 
e host computer as a database server, copy the 

ile.txt > .profile [Enter]   

$ . ./.profile [Enter] 

To simplify the Oracle installation, you can copy the data from the Oracle installation CDs onto the 
computer. Use the instructions in Installing Oracle 9i or Installing Oracle 10g to copy the data from 

Log in to the system as the Oracle user. 

Create the env

PATH=$PATH:/usr/local/bin:/usr/ccs/bin:/usr/openwin/bin:/usr/bin/X11 

export PATH  

(Oracle 9i)ORACLE_HOME=/u01/app/oracle/product/9.2.0S

(Oracle 10g)ORACLE_HOME=/u01/app/oracle/produ

ORACLE_BASE=/u01/app/oracle; export OR

PATH=$PATH:$ORACLE_HOME/bin; export PATH

ORACLE_SID=pidb; export ORACLE_SID 

TNS_ADMIN=/var/opt/oracle; export TNS_ADMIN 

NLS_LANG=American_America.UTF8; export NLS_LANG 

The environmental parameters in the pre
this is the first time you are configuring th
profile.txt file to .profile: 

$ cat agilepitmp/prof
4. Update the environmental setting: 

Making the Oracle Installer Available 
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the installation CDs. 

Installing the Oracle Database 

Use the instructions in Installing Oracle 9i or Installing Oracle 10g to install the Oracle database, if it 

base instance and schema used by Product 
se creation utility.       

ge Oracle SID. By default, Agile uses pidb as the 

Important s not 

Note Generally, the SID length is four alphanumeric characters. This avoids lengthy database 

is not already installed. 

Creating the Product Interchange Database 
This section describes how to create the default data
Interchange using the databa

To start the installation:     

1. Log in to the computer as the Oracle user. 

2. If necessary, edit the .profile file to chan
Oracle SID:        

3. $ vi .profile [Enter]   

4. Modify the value where ORACLE_SID=pidb by replacing pidb with the SID you want to use. 

Check the /var/opt/oracle/oratab file and make sure that the specified Oracle SID ha
been used. Specifying an existing Oracle SID can corrupt that database instance. 

filenames for associated database files. 

5.  take effect: 

 the computer as the root user. 

7. e a 

Note 

Run .profile to make the SID changes

$. ./chmod u+x .profile    [Enter]    

6. In a second terminal session, log in to

Creat directory named “oradata.” 

The pidb.sh file uses a dummy mount point /mpt. You must change /mpt to 
match your mount points. For OFA compliance, it is highly recommended that 
you create at least four mount points (preferably on four different disks across 
multiple controllers) to optimize disk I/O. 

For example, if you have mount point
each mount point. 

s at /u01 and /u02, you can create an oradata folder on 

8. as the Oracle user, create a $ORACLE_BASE/admin 

er] 

10. Modify the pidb.sh script to match the mount points on your computer, and then copy the script 

# mkdir -p /u01/oradata
# chown oracle:dba /u01/oradata
In the session where you are logged in 
directory: 

$ mkdir -p /u01/app/oracle/admin [Ent

You must now run the pidb.sh script. 

9. Change to the /u01/oracle/agilepitmp directory. 

to the Oracle user home directory (/u01/oracle). 
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Important hes the one you set for .profile, which should have taken 
effe

Note 

Make sure ORACLE_SID matc
ct after you ran . ./.profile. 

The pidb.sh file uses a dummy mount point /mpt. You must change /mpt to 
match your mount points. For OFA compliance, it is highly recommended that 
you create at least four mount points (preferably on four different disks across 
multiple controllers) to optimize disk I/O. 

The values in the script that can be modified appear in bold. You should limit your editing only 

.sh and quickly 
     

sh | sed -e "s/mpt\//u01\//g" > /u01/oracle/pidb.sh
od u

Note iable in bold that you may want to revise besides 

to these bold values. 

For example, if you have a mount point created at /u01, you can modify pidb
recreate it in the Oracle user home directory by issuing one command.   

$ cat /u01/oracle/agilepitmp/pidb.
$ chm +x /u01/oracle/pidb.sh

The following code list var
dummy mount point /mpt 

#!/bin/sh 

racle_sid default as pidb 

 database 

chema 

hema 

EPW=dwe         # Oracle passwd for DWE 

cation of datafiles,  
ontrolfiles and logfiles 

e

X tablespace

# 

# O

# 

ORACLE_SID=pidb     # Oracle SID for the database 

AASYSPW=oracle       # Oracle sys passwd for the database 

AASYSTEMPW=manager   # Oracle system passwd for the

PIUSER=piuser      # Oracle account for piuser s

PIUSERPW=piuser   # Oracle passwd for piuser 

DWE=dwe           # Oracle account for DWE sc

DW

# 

# Parameters determine lo
# c

# 
DATABASE_SYSTEM=/mpt/oradata/${ORACLE_SID} # SYSTEM tablespace

DATABASE_SYSAUX=/mpt/oradata/${ORACLE_SID} # SYSAUX tablespace

DATABASE_TOOLS=/mpt/oradata/${ORACLE_SID}  # TOOLS tablespac

DATABASE_UNDO=/mpt/oradata/${ORACLE_SID}   # RBS tablespace

DATABASE_TEMP=/mpt/oradata/${ORACLE_SID}   # TEMP tablespace

DATABASE_USERS=/mpt/oradata/${ORACLE_SID}  # USERS tablespace

DATABASE_INDX=/mpt/oradata/${ORACLE_SID}   # IND

DATABASE_AGILE_DATA1=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX1=/mpt/oradata/${ORACLE_SID}
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DATABASE_AGILE_DATA2=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX2=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_DATA3=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX3=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_DATA4=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX4=/mpt/oradata/${ORACLE_SID}

DATABASE_LOGFILES1=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 1

DATABASE_LOGFILES2=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 2

DATABASE_LOGFILES3=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 3

DATABASE_LOGFILES4=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 4

DATABASE_CONTROL1=/mpt/oradata/${ORACLE_SID}   # CONTROL file 1

DATABASE_CONTROL2=/mpt/oradata/${ORACLE_SID}   # CONTROL file 2

DATABASE_CONTROL3=/mpt/oradata/${ORACLE_SID}   # CONTROL file 3

DATABASE_ARCHIVE=/mpt/oradata/${ORACLE_SID}/arch  #ARCHIVELOGS

Parameters determine character set used 

11. .sh script from the Oracle user home directory: 

pischema.dmp . [Enter] 

b.sh

Note  you may have to give the system user full 

#

# 

#

CHARACTER_SET=UTF8

NATIONAL_CHARACTER_SET=UTF8

Run the pidb

$ cd [Enter] 

$ cp agilepitmp/agile
$ ./pid  [Enter] 

If you are unable to create files,
privileges to the u01 directory. 

12. 

tions 
 that the computer meets the minimum 

 database size. 

Important 
se. It is recommended to change these passwords periodically for 

st-installation tasks. 

Post-Installation Tasks 
re Oracle Net Manager, and set the automatic startup and 

shutdown features for the database. 

You are prompted about the database size that you want to install. 

You should use the regular database size unless you have consulted with an Agile Solu
Consultant or database administrator to ensure
requirements for the specified

The script will run for awhile. 

Change all Oracle database user passwords after you have created the Product 
Interchange databa
security purposes. 

13. Continue to the next section for po
 

This section describes how to configu
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Setting Up Oracle Net Manager 

To set up Oracle Net Manager: 

1. Log in as root and change the ownership of the /var/opt/oracle directory: 

# chown -R oracle:dba /var/opt/oracle [Enter] 

2. Switch to the Oracle user, and change to the Oracle network directory: 

# su - oracle [Enter]   

$ cd Oracle_Home [Enter] 

3. Move all the files to the directory defined by environmental parameter TNS_ADMIN, which is 
/var/opt/oracle: 

$ mv * /var/opt/oracle [Enter] 

Setting Up Automatic Shutdown and Startup for the Database 

To set up the Oracle database to automatically shut down and start up when the host 
computer starts up and shuts down: 

1. Log in the system as root. 
2. Create a file named “dbora” in the /etc/init.d directory:  

# cat /u01/oracle/agilepitmp/dbora > /etc/init.d/dbora [Enter] 

3. Link to the dbora file:    

# ln -s /etc/init.d/dbora /etc/rc0.d/K10dbora  [Enter]   

# ln -s /etc/init.d/dbora /etc/rc2.d/S99dbora  [Enter]   
 

Configuring the listener.ora File 

To configure the listener.ora file:         

1. Start Net Manager: 

$ netmgr &
2. Within the Local folder, open the Listeners folder and select LISTENER. 

1. Check to see if the following settings appear in one of the Address tabs: 
 Protocol: TCP/IP 
 Host: the host computer where the Oracle database is installed 
 Port: 1521 

2. If the information does not appear, click Add Address. A new Address tab appears. 

3. Type these settings: 
 Protocol: TCP/IP 
 Host: the host computer where the Oracle database is installed 
 Port: 1521 

4. Select Database Service in the Listener Location drop-down list. 

5. Click Add Database. In the dialog box that appears, make the following changes: 
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 Global Database Name: pidb 
 Oracle Home Directory: Oracle_Home 
 SID: pidb 

Note If you used a different global database name or different home directory during 
the database installation, change the information as appropriate. 

3. Choose File > Save Network Configuration to save your changes. 

4. Close Net Manager. 
 

Configuring the tnsnames.ora File (Optional) 
1. In the Oracle Net Manager window, double-click the Local folder and select the Service Naming 

folder.         

2. Click Create  in the toolbar to add a service name. 

The Net Service Name Wizard starts.    

3. In the Net Service Name field, type the name of the computer where the Oracle database is 
located (usually the current computer). Click Next.      

4. You are prompted to select a network protocol. Select TCP/IP (Internet Protocol) and click Next. 
5. Type the name of the computer where Oracle is located in the Hostname field (the same name 

you typed in step 3). Accept 1521 as the default port number. Click Next. 
6. Select Oracle8i or later as the service name, and type pidb in the field. Click Next. 
7. Click Test to test the service. 

The test initially fails because the default uses the incorrect login.    

8. Click Change Login to reset the username and password.     

9. Type piuser in the Username field and piuser in the Password field. Click OK. 

10. Click Test. You should now see a message indicating that the test was successful. Click Close.  

11. Click Finish to exit the Net Service Name Wizard. 

12. From the Net Manager menu, choose File > Save Network Configuration to save the service name. 

This completes the installation and configuration for Oracle on Solaris. 
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Installing and Configuring the Product 
Interchange Application 

This chapter includes the following: 

 Starting the Product Interchange Installer ........................................................................................................... 19 
 Before you Begin ................................................................................................................................................. 20 
 Installer Panels .................................................................................................................................................... 20 
 Installer Online Help ............................................................................................................................................ 22 
 Installer Buttons ................................................................................................................................................... 22 
 Configuring the Apache Tomcat Service ............................................................................................................. 23 
 Testing the Installation......................................................................................................................................... 24 

 
 

Starting the Product Interchange Installer 
The Product Interchange installer is a Java program. Before running the installer, make sure: 

 You have enough available disk space. 

Windows: at least 500MB of available disk space 

 You have disabled virus protection. 

If virus protection is enabled, components used in the installer can be falsely identified as being 
infected and lock up the installation. You can enable virus protection after the installation is 
complete. 

To start the Product Interchange installer on Windows: 

1.  Log in to the computer using a login with local Administrator permissions. 

2.  In the Disk1\Windows\AgilePI directory, double-click the setup.exe file. 

Note If there is insufficient Temp disk space available to complete the installation, 
you will be prompted for another location. Click Choose, select another drive, 
Click OK, and the installer will start. 

After a few moments, the Welcome screen appears.  

For information about any screen in the installer, click Help. Follow the installer prompts to proceed 
with the installation.  

Once you finish installation, the AgilePI folder appears within the Agile home folder and the Apache 
Tomcat service is added to your system. Start this service to also start Agile PI. 
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Before you Begin 
When you run the Agile Product Interchange Installer, your system settings may prevent the 
Dralasoft software from being installed properly. To avoid this, change your settings as described 
here. 

To ensure proper installation of Dralasoft software: 

1. Choose Start > Control Panel.  
2. Double-click on System to view system properties.  

3. In the Advanced tab, under Performance, click Settings. 

4. In the Data Execution Prevention tab, select the second option "Turn on DEP for all programs and 
services except those I select." 

5. Click Add.  

6. Browse and select the Product Interchange executable. Click Open. The executable appears in 
the list. 

7. Click Add again and select the Dralasoft executable (setupdwe.exe) from the Dralasoft folder. 

8. Click OK. 

 
 

Installer Panels 
The Agile Product Interchange Installer has the following panels.  

Panel  Step(s)  to  Per form 

Welcome Click Next. 

License Agreement Read the license agreement, and then select  I accept the terms of the 
license agreement. 

Customer Information Enter your user name and company name. 

Choose Install Component(s) Select Product Interchange.  

Installation Location Enter the directory where you want to install Product Interchange.  

Agile PLM Database Details Enter your Agile PLM database information.  

Agile Database Host Name - The fully qualified domain name of the 
computer where the Agile PLM database server is installed. 

Agile Database Port - For Oracle, the default database port is 
1521. 

Agile Database SID - Enter the Oracle System Identifier that refers 
to the instance of the Oracle database running on the server. 
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Panel  Step(s)  to  Per form 

The default SID is agile9. 

Agile Database User - Enter the database user. The default user is 
agile. 

Agile Database User Password - Enter the password for the Agile 
PLM database user. The default password is tartan. 

If your Agile PLM database is configured to use different values than the 
defaults listed above, specify that information instead. 

Tomcat Listen Ports Specify the Tomcat listen ports. 

Tomcat Listen Port (non-SSL) - Enter the Tomcat listen port. The default 
port is 8080. 

Tomcat Secure Listen Port (SSL) - Enter the Tomcat secure listen port. 
The default port is 8443. You may also use the industry standard SSL port 
443 if it is available. 

You should accept the default ports unless you know they are unavailable. 

SMTP Information Enter the SMTP server information that Product InterChange uses. SMTP is 
short for Simple Mail Transfer Protocol, a protocol for sending e-mail 
messages between servers. 

The Product InterChange application uses this information email any 
exceptions that it encounters in its Web Controller. Product InterChange 
must be able to send both internal and external email from this host. 
Otherwise, the application will fail. 

SMTP Server Name - Enter the fully qualified domain name of the  SMTP 
server name. 

Email Address - Enter the email address of the Product InterChange 
administrator. 

Agile Product Interchange Database 
Details

Enter your Agile Product Interchange database information. If you do not 
know these Oracle database values, see the database administrator 
responsible for your Product Interchange database server. 

Database Host Name - Enter the fully qualified domain name of the 
computer where the Product Interchange database server is installed. 

Database Port - Enter the database port. For Oracle, the default database 
port is 1521. 

Database SID - Enter the Oracle System Identifier that refers to the instance 
of the Oracle database running on the server. The default SID for Product 
Interchange is pidb. 

Database User - Enter the Product Interchange database user. The default 
database user is piuser. 

Database User Password - Enter the password for the Product Interchange 
database user. The default password is piuser. 
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Panel  Step(s)  to  Per form 

Agile Application Server 
Information

Enter the machine name and port number where Agile PLM is installed. If 
not already installed, enter details of the machine where you intend to install 
Agile PLM. 

Agile Application Server Host Name
Enter the fully qualified domain name for the Agile Application Server. 

Agile Application Server Port
Enter the HTTP listen port for the application server. The port depends on 
type of application server you are using. For Oracle Application Server, the 
default port is 7777. For BEA WebLogic Server, the default port is 7001. 

Agile Application Enter the virtual path of the Agile PLM application server installation. The 
default is 'Agile'. 

 

Pre-Installation Summary
Review the information you provided in previous panels to make sure it's 
correct before you install. 

If the information is correct, click Install. If you need to make any changes, 
click Previous to go to a previous panel. 

Install Complete You have finished the Product Interchange installation. 

Click Done to close the installer. 

 
 

Installer Online Help 
Each installation panel has online help. At any time during installation, you can click Help for more 
information about the panel’s options. 

Note If you leave the online help window open, it will be updated when you proceed 
through the installer panels. Otherwise, click Close at the bottom of the help 
window. 

 

Installer Buttons 
Agile Product Interchange installation panels have the following buttons: 

 Cancel  — Exits from the installation program. 

 Help — Displays online help. 

 Previous — Returns to the previous step. 

 Next  — Proceeds to the next step. 

 Install  — Starts installing. The Install button appears only on the Pre-Installation Summary 
panel, after you have specified installation options. 

 Done  — Exits from the installation program. On Windows, after installing certain components 

Page - 22 Agile Product Lifecycle Management 

 

 



 Chapter 3  
 
 

you can choose whether to restart the computer when you click Done. The Done button appears 
only on the Install Complete panel, after you have finished installing. 

ice. 
Before starting the Apache Tomcat service, you must configure it for Agile Product Interchange. 

Note M application server is up and running before performing 

 

Configuring the Apache Tomcat Service 
Agile Product Interchange uses the Apache Tomcat server, which is installed as a Windows serv

Make sure that the Agile PL
these configuration steps. 

To configure the Apache Tomcat service for Agile Product Interchange: 

1. figure Tomcat.  Choose  Start > All Programs > Apache  Tomcat 5.0 > Con
The Apache Tomcat Properties dialog box appears. 

 
 On the 2.  ensures that the 

will start automatically when you restart the server. 

4. ine and Java Classpath options point to the location for Java 
lopment

Note th Agile Product Interchange and is 

General tab, make sure the Startup Type option is set to Automatic. This
Apache Tomcat service 

3.  Click the Java tab. 

 Make sure the Java Virtual Mach
Deve  Kit (JDK) 1.4.2. 

JDK 1.4.2 is installed automatically wi
located in the \agile_home\jdk folder. 

5. ons box, remove the entry for java.endorsed.dirs. The complete entry to remove  In the Java Opti
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looks like this: 

-Djava.endorsed.dirs=D:\Agile\Agile922\Tomcat\common\endorsed

ry Pool size to 1024 (MB). 

9. 

their filenames by modifying the Log Path, Redirect Stdout, 

11.  Apache Tomcat service is 
,” click Stop to stop the service. 

13.  Click OK to close the Apache Tomcat Properties dialog box. 

 
has lowing URL: 

s://<Agile-PI-Host-Name>:<SSL-Port>/orexec/SignInRequest.fma?orgId=1 

whe

omain name of the machine where the Agile 

istens to. If you are using the 
SSL port from the URL. 

Her

Id=1

6.  Set the Initial Memory Pool size to 512 (MB). 

7.  Set the Maximum Memo
8.  Click the Logging tab. 

 By default, Apache Tomcat saves stdout and stderr log files in the agile_home\Tomcat\logs 
folder. These files are excellent resources for troubleshooting errors. Optionally, you can 
change the location of these files and 
and Redirect Stderr options. 

10.  Click the General tab again. 

 Toward the bottom of the tab, Service Status indicates whether the
started. If Service Status is “Started

12.  Click Start to restart the service. 

 

Testing the Installation 
After the Agile Product Interchange application has been installed and the Apache Tomcat service

 been started, open a browser window and test the installation by going to the fol

http

re 

<Agile-PI-Host-Name> is the fully qualified d
Product Interchange application is installed 

<SSL-Port> is the Secure Sockets Layer (SSL) port that Tomcat l
default SSL port (443), you can omit the 

e are examples of URLs you might type: 

https://piserver.mycompany.com:8443/orexec/SignInRequest.fma?org

https://piserver.mycompany.com/orexec/SignInRequest.fma?orgId=1

Use the following username/password logins to verify the installation: 

 agileuser1/agile 
 

 admin/agile 
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Chapter 4 

Using the Agile Product Interchange 
DataLoad Utility 

This chapter includes the following: 

 Unpacking and Configuring the Agile Product Interchange DataLoad Utility....................................................... 25 
 Data File Formats ................................................................................................................................................ 25 
 Loading Manufacturer Aliases ............................................................................................................................. 27 
 Loading Manufacturer Part Number Aliases........................................................................................................ 28 
 Loading Manufacturer Codes .............................................................................................................................. 29 
 Loading Commodity Codes ................................................................................................................................. 29 
 Getting Aliases for Manufacturers and Manufacturer Parts................................................................................. 30 

This section describes how to use the Agile Product Interchange DataLoad utility to load customer 
data for manufacturer aliases (internal and external), part aliases, and manufacturer codes. 
 

Unpacking and Configuring the Agile Product 
Interchange DataLoad Utility 
The Agile Product Interchange DataLoad utility (pidataload.zip) is installed into the following folder 
on your Agile Product Interchange application machine: 

agile_home\AgilePI\pidataload 

To extract and configure the Agile Product Interchange DataLoad utility: 

1.  In the pidataload folder, open pidataload.zip using WinZip or another archive utility. Extract the 
contents of the file to the same folder. 

2.  Edit the database details in the config.properties file found in the following folder: 

agile_home\AgilePI\pidataload\config 

For guidelines on how to edit the config.properties file, read instructions in the file. 
 

Data File Formats 
Before loading data into Agile Product Interchange using the DataLoad utility, make sure your 
Microsoft Excel data files conform to the proper format. 

Internal Manufacturer Alias Format 
The Microsoft Excel file used for internal manufacturer aliases should have the following format: 

 Column A should contain internal standard manufacturers. 
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 Column B should contain aliases. 

 The first row of the file should be the header. 

T the format al manufacturer alias file. he following table shows for an intern

In terna l  Standard  Mfr  A l ias  Mfr  

PANASONIC PANASONIC CORP 

PANASONIC PANASONIC INC 

PANASONIC PANASONIC LTD 

MICROSEMI MICROSEMI DIV 

MICROSEMI MICROSEMI INC 

 
 

External Manufacturer Alias Format 
The Microsoft Excel file used for external manufacturer aliases should have the following format: 

cturer aliases. 

The  format for an exte r alias file. 

 Column A should contain standard manufacturers. 

 Column B should contain DataSource manufa

 The first row of the file should be the header. 

following table shows the rnal manufacture

In terna l  Standard  Mfr  PartMiner  Mfr  

3M PRODUCTS 3M INTERCONNECT SOLUTIONS 

AAVID THERMAL PRODUCTS AAVID THERMALLOY 

ADVANCED POWER SOLUTIONS  TECHNOLOGY ADVANCED POWER

AGERE AGERE SYSTEMS 

 
 

Manufacturer Part Number Alias Format 
The Microsoft Excel file used for manufacturer part num
format: 

ber aliases should have the following 

rers. 

 row of ld be the header

following tab rmat er alia

 Column A should contain the dirty manufacturers. 

 Column B should contain the dirty parts. 

 Column C should contain the clean manufactu

 Column D should contain the clean parts. 

The first  the file shou . 

The le shows the fo  for an manufacturer part numb s file. 
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Dirty  Mfr  D i r ty  Part  C lean  Mfr  C lean  Par t  

3M 152244-0113GG G 3M INTERCONNECT SOLUTIONS 1522440113G

3M 2304-6111TG 3M INTERCONNECT SOLUTIONS 23046111TG 

3M 2402-6112TB 3M INTERCONNECT SOLUTIONS 24026112TB 

 
 

Manufacturer Code Format 
The Microsoft Excel file used for manufacturer codes should have the following format: 

de. 

The followin ws the format facturer code file. 

 Column A should contain the manufacturer name. 

 Column B should contain the manufacturer co

 The first row of the file should be the header. 

g table sho  for a manu

Mfr  Name Mfr  Code 

3L ELECTRONIC CORP 7095 

NETERGY MICROELECTRONICS 2018 

8 X 8 INC 4659 

 
 

Commodity Code Format 
The Microsoft Excel file used for commodity codes should have the following format: 

er Commodity Code. 

The following table shows the format for e

 Column A should contain the internal commodity code. 

 Column B should contain the description of the commodity. 

 Column C should contain the corresponding PartMin

 The first row of the file should be the header. 

a commodity cod  file. 

In a l  Commodity  Code tern Descr ipt ion PartMiner  Commodity  Code 

06370 IC,MEMORY,EPROM 4420 

06400 IC,PROC 3780 

06500 IC,ANALOG 3690 

 
 

Loading Manufacturer Aliases 
Use the runMfrAliasLoader.bat script to load manufacturer aliases into your system. 
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To load manufacturer aliases from an internal data source: 

1.  Open a Command Prompt window. 

2.  Change directories to the agile_home\AgilePI\pidataload directory. 

3.  Run a script called runMfrAliasLoader.bat using the following syntax: 

runMfrAliasLoader <MfrAliases_Datafile_Path> <Config_File_Path> 

 

where 

<MfrAliases_Datafile_Path> is the path to the internal manufacturer alias data file. 

<Config_File_Path> is the path to the config.properties file for the Agile Product Interchange 
DataLoad utility. 

For example: 

runMfrAliasLoader.bat "d:\Agile\Agile9221\AgilePI\pidataLoad\files\InternalAliasesData.xls" 

"d:\Agile\Agile9221\AgilePI\pidataLoad\config\config.properties" 

To load manufacturer aliases from an external data source: 

1.  Open a Command Prompt window. 

2.  Change directories to the agile_home\AgilePI\pidataload directory. 

3.  Run a script called runMfrAliasLoader.bat using the following syntax: 

runMfrAliasLoader <MfrAliases_Datafile_Path> <DataSource_Org_Name> <Config_File_Path> 

 

where 

<MfrAliases_Datafile_Path> is the path to the external manufacturer alias data file. 

<DataSource_Org_Name> is the data source organization name exactly as configured in Agile 
Product Interchange. 

Note You can see the list of Organizations in Agile Product Interchange. Log in as admin 
and create a new Data Source Profile. 

<Config_File_Path> is the path to the config.properties file for the Agile Product Interchange 
DataLoad utility. 

For example: 

runMfrAliasLoader.bat "d:\Agile\Agile9221\AgilePI\pidataLoad\files\ExternalAliasesData.xls" 
"PartMiner" 

"d:\Agile\Agile9221\AgilePI\pidataLoad\config\config.properties" 

Loading Manufacturer Part Number Aliases 
Use the runMpnAliasLoader.bat script to load manufacturer part number aliases into your system. 

To load manufacturer part number aliases: 

1.  Open a Command Prompt window. 
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2.  Change directories to the agile_home\AgilePI\pidataload directory. 

3.  Run a script called runMpnAliasLoader.bat using the following syntax: 

runMpnAliasLoader <MpnAliases_Datafile_Path> <DataSource_Profile_Name> 
<Config_File_Path> 

where 

<MpnAliases_Datafile_Path> is the path to the manufacturer part number alias data file. 

<DataSource_Profile_Name> is the data source profile name exactly as configured in Agile 
Product Interchange. 

Note A valid data source profile is one of the data source profile names that you get as 
result when you search for all Data Source Profiles in Agile Product Interchange. 

<Config_File_Path> is the path to the config.properties file for the Agile Product Interchange 
DataLoad utility. 

For example: 

runMpnAliasLoader.bat "d:\Agile\Agile9221\AgilePI\pidataLoad\files\mpndl.xls" "PartMiner" 

"d:\Agile\Agile9221\AgilePI\pidataLoad\config\config.properties" 

Loading Manufacturer Codes 
Use the runMfrCodesLoader.bat script to load manufacturer codes into your system. 

To load manufacturer codes: 

1.  Open a Command Prompt window. 

2.  Change directories to the agile_home\AgilePI\pidataload directory. 

3.  Run a script called runMfrCodesLoader.bat using the following syntax: 

runMfrCodesLoader <MfrCodes_Datafile_Path> <Config_File_Path> 

 

where 

<MfrCodes_Datafile_Path> is the path to the manufacturer codes data file. 

<Config_File_Path> is the path to the config.properties file for the Agile Product Interchange 
DataLoad utility. 

For example: 

runMfrCodesLoader.bat "d:\Agile\Agile9221\AgilePI\pidataLoad\files\mfrcodes.xls" 

"d:\Agile\Agile9221\AgilePI\pidataLoad\config\config.properties" 

Loading Commodity Codes 
Use the runCommodityDetails.bat script to load commodity codes into your system. 

To load commodity codes: 

1.  Open a Command Prompt window. 
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2.  Change directories to the agile_home\AgilePI\pidataload directory. 

3.  Run a script called runCommodityDetails.bat using the following syntax: 

runCommodityDetails <CommodityCodes_Datafile_Path> <Config_File_Path> 

 

where 

<CommodityCodes_Datafile_Path> is the path to the commodity codes data file. 

<Config_File_Path> is the path to the config.properties file for the Agile Product Interchange 
DataLoad utility. 

For example: 

runCommodityDetails.bat "d:\Agile\Agile9221\AgilePI\pidataLoad\files\commoditycodes.xls" 

"d:\Agile\Agile9221\AgilePI\pidataLoad\config\config.properties" 

Getting Aliases for Manufacturers and 
Manufacturer Parts 
Use the following scripts to create output files containing the aliases for manufacturers and 
manufacturer parts from your system: 

 runInternalMfrAliasesGetter.bat 

 runExternalMfrAliasesGetter.bat 

 runMpnAliasGetter.bat 

To get manufacturer aliases for an internal data source: 

1.  Open a Command Prompt window. 

2.  Change directories to the agile_home\AgilePI\pidataload directory. 

3.  Run a script called runInternalMfrAliasesGetter.bat using the following syntax: 

runInternalMfrAliasesGetter <Output_File> <Config_File_Path> 

 

where 

<Output_File> is the path to the output file that the script generates. 

<Config_File_Path> is the path to the config.properties file for the Agile Product Interchange 
DataLoad utility. 

For example: 

runInternalMfrAliasesGetter.bat 

"d:\Agile\Agile9221\AgilePI\pidataLoad\aliasFiles\InternalMfrAliases.txt" 

"d:\Agile\Agile9221\AgilePI\pidataLoad\config\config.properties" 

To get manufacturer aliases for external data sources: 

1.  Open a Command Prompt window. 
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2.  Change directories to the agile_home\AgilePI\pidataload directory. 

3.  Run a script called runExternalMfrAliasesGetter.bat using the following syntax: 

runExternalMfrAliasesGetter <Output_File> <Config_File_Path> 

 

where 

<Output_File> is the path to the output file that the script generates. 

<Config_File_Path> is the path to the config.properties file for the Agile Product Interchange 
DataLoad utility. 

For example: 

runExternalMfrAliasesGetter.bat 

"d:\Agile\Agile9221\AgilePI\pidataLoad\aliasFiles\ExternalMfrAliases.txt" 

"d:\Agile\Agile9221\AgilePI\pidataLoad\config\config.properties" 

To get the mapping table for manufacturer part aliases: 

1.  Open a Command Prompt window. 

2.  Change directories to the agile_home\AgilePI\pidataload directory. 

3.  Run a script called runMpnAliasGetter.bat using the following syntax: 

runMpnAliasGetter <Output_File> <Config_File_Path> 

 

where 

<Output_File> is the path to the output file that the script generates. 

<Config_File_Path> is the path to the config.properties file for the Agile Product Interchange 
DataLoad utility. 

For example: 

runMpnAliasGetter 

"d:\Agile\Agile9221\AgilePI\pidataLoad\aliasFiles\PartAliases.txt" 

"d:\Agile\Agile9221\AgilePI\pidataLoad\config\config.properties" 
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Upgrading the Product Interchange 
Database 

This chapter includes the following: 

 Upgrade Procedure ............................................................................................................................................. 33 
 
 

Upgrade Procedure 
If you have Product Interchange version 9.0 SP4, 9.0 SP5 Hotfix 1, 9.2, 9.2.1, 9.2.2, or 9.2.2.1 
installed, you can upgrade your database to Product Interchange database version 9.2.2.2. 

Before upgrading, you MUST install the Product Interchange application. After installing Product 
Interchange, the directory containing the upgrade scripts is created.  

To upgrade the Product Interchange database from version 9.0 SP4 to version 9.2.2.2: 

1. On the database server, back up the Product Interchange database by exporting the piuser and 
dwe schemas. 

2. Open a Command Prompt window on the machine where Product Interchange 9.2.2.1 is 
installed. 

3. Change to the agile_home\AgilePI\upgrade directory. 

4. Log in to SQL*Plus as the piuser: 

sqlplus piuser/piuser@oracle-sid

5. Run the 90sp4to921.sql upgrade script. 

6. Run the 921HF4to921HF13.sql upgrade script. 

7. Back up the upgraded database by exporting the piuser and dwe schemas. 

To upgrade the Product Interchange database from version 9.0 SP5 Hotfix 1 to version 
9.2.2.2: 

1. Check to make sure the i2, Arrow, and Avnet data source profiles exist in the Product 
Interchange application. If they do not exist, you need to run additional upgrade scripts in steps 
described below. 

2. On the database server, back up the database by exporting the piuser and dwe schemas. 

3. Open a Command Prompt window on the machine where Product Interchange 9.2.2.1 is 
installed. 

4. Change to the agile_home\AgilePI\upgrade directory. 

5. Log in to SQL*Plus as the piuser: 

sqlplus piuser/piuser@oracle-sid
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6. Run the 90sp5HF1to921.sql upgrade script. 

7. Run the 921HF4to921HF13.sql upgrade script. 

8. If the i2 data source profile needs to be created, run the following script: i2DSProfile.sql. 

If the Avnet data source profile needs to be created, run the following script: 
AvnetDSProfile.sql. 

9. If the Arrow data source profile needs to be created, run the following script: 
ArrowDSProfile.sql. 

10. Back up the upgraded database by exporting the piuser and dwe schemas. 

To upgrade the Product Interchange database from version 9.2 to version 9.2.2.2: 

1. On the database server, back up the database by exporting the piuser and dwe schemas. 

2. Open a Command Prompt window on the machine where Product Interchange 9.2.2.1 is 
installed. 

3. Change to the agile_home\AgilePI\upgrade directory. 

4. Edit the 92to921.sql file with the following steps: 

1. Replace the string @AlterTable.sql with @alterTable921.sql. 
2. Replace the following lines: 

--===== Drop Columns from PmPartMatches =====-- 

@dropColumns.sql; 

 

with 

--===== ADD Columns to PMPartMatches =====-- 

ALTER TABLE PM_PART_MATCHES ADD ( 

  ROHS               VARCHAR2(15) NULL, 

  LEADFREE           VARCHAR2(15) NULL, 

  LAST_ORDER         VARCHAR2(55) NULL, 

  LAST_SHIP          VARCHAR2(55) NULL, 

  TOTAL_WEIGHT       VARCHAR2(55) NULL, 

  PACKAGE_MATERIAL   VARCHAR2(55) NULL, 

  STATUS             VARCHAR2(55) NULL, 

  LIFECYCLE_STAGE    VARCHAR2(55) NULL 

); 

 

ALTER TABLE PM_PART_MATCHES MODIFY PART_URL 

VARCHAR2(550); 

5. Edit the dropColumns.sql file by removing the following lines at the end of the file: 

ALTER TABLE PM_PART_MATCHES ADD ( 
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  ROHS              VARCHAR2(15) NULL, 

  LEADFREE          VARCHAR2(15) NULL, 

  LAST_ORDER        VARCHAR2(55) NULL, 

  LAST_SHIP         VARCHAR2(55) NULL, 

  TOTAL_WEIGHT      VARCHAR2(55) NULL, 

  PACKAGE_MATERIAL  VARCHAR2(55) NULL, 

  STATUS            VARCHAR2(55) NULL, 

  LIFECYCLE_STAGE   VARCHAR2(55) NULL, 

); 

 

ALTER TABLE PM_PART_MATCHES MODIFY PART_URL 

VARCHAR2(550); 

6. Log in to SQL*Plus as the piuser: 

sqlplus piuser/piuser@oracle-sid

7. Change to the agile_home\AgilePI\pidataload\config directory. 

8. Edit the config.properties file with the Agile PLM database details, then save the file. 

Change to the agile_home\AgilePI\pidataload directory. 

9. Run the run92To921Upgrador file with the edited configuration file, as follows: 
run92To921Upgrador \\pidataload\config\config.properties

1.  If all of the previous steps have completed successfully, log in to SQL*Plus and run the 
dropColumns.sql script in the agile_home\AgilePI\upgrade directory. 

2.  Run the 921HF4to921FH13.sql upgrade script. 

 

To upgrade the Product Interchange database from version 9.2.1 to version 9.2.2.2: 

1. On the database server, back up the database by exporting the piuser and dwe schemas. 

2. Open a Command Prompt window on the machine where Product Interchange 9.2.2.1 is 
installed. 

3. Change to the agile_home\AgilePI\upgrade directory. 

4. Log in to SQL*Plus as the piuser: 

sqlplus piuser/piuser@oracle-sid

5. Run the 921HF4to921HF13.sql upgrade script. 

6. Back up the upgraded database by exporting the piuser and dwe schemas. 
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